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DejaVu til QuarkXPress og QuarkXPress Passport 5.0 ‘ A l

Dejavu’” er QuarkXTensions™software tl QuarkXPress™ oy [T

QuarkXPress Passport™, der satter dig i stand til at fa adgang til
tekst, billeder og dokumenter hurtigere og nemmere. DejaVu
gor dette ved at vise dig en liste over nyligt dbnede dokumenter . Installation af DejaVu til Mac OS
som en hierarkisk menu fra undermenuen Arkiv (Mac OS) -

Abn eller Fil (Windows) - Abn, eller nederst i menuen Arkiv . Installation af DejaVu til Windows
(Ma.c OS) eller Fil (Windows). Herudover' giver D.e]‘aVu dig . Brug af DejaVu

mulighed for at angive standardmapper til hentning af tekst
og billeder og dbning og arkivering af dokumenter. . Kendte problemer

. Minimumsystemkrav

. Kontakt Quark

. Juridiske oplysninger
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Minimumsystemkrav

Til Mac OS og Windows
QuarkXPress 5.0 eller QuarkXPress Passport 5.0
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Installation af DejaVu til Mac OS

Folg nedenstdende trin for at installere DejaVu:
1 Afslut QuarkXPress eller QuarkXPress Passport.

2 Kopiér arkivet “DejaVu” fra QuarkXPress-CD-ROM’en til
mappen “XTension” indeni QuarkXPress-programmappen.

3 Start QuarkXPress for at fd adgang til funktionerne i DejaVu.
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Installation af DejaVu til Windows

Folg nedenstdende trin for at installere DejaVu:
1 Afslut QuarkXPress eller QuarkXPress Passport.

2 Kopieér filen “DejaVu.xnt” fra QuarkXPress-CD-ROM’en til
mappen “XTension” indeni QuarkXPress-programmappen.

3 Start QuarkXPress for at fd adgang til funktionerne i DejaVu.
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Brug af DejaVu

Arkivliste (Mac OS) eller Filliste (Windows)

Funktionen Arkivliste (Mac OS) eller Filliste (Windows) giver
dig mulighed for at veelge det QuarkXPress-dokument, der skal
redigeres pd en liste over nyligt abnede og gemte dokumenter.
Dette giver dig direkte adgang til QuarkXPress-dokumenter,
uden at du behgver at vaelge Arkiv - Abn (Mac OS) eller Fil -~
Abn (Windows). Arkivliste (Mac OS) eller Filliste (Windows)
aktiveres, ndr programmet startes, og anvender standardindstil-
linger, der viser tre arkivnavne i alfabetisk raeekkefglge nederst
pa menuen Arkiv (Mac OS) eller Fil (Windows). Du kan veelge
at fa vist helt ned til tre (eller helt op til ni) nyligt redigerede
og gemte dokumenter. Du kan ogsa valge at fa vist Arkivliste
(Mac OS) eller Filliste (Windows) nederst pd menuen Arkiv
(Mac OS) eller Fil (Windows) eller som en hierarkisk menu, der
udloses af kommandoen Arkiv - Abn (Mac OS) eller Fil >
Abn (Windows). Herudover kan du konfigurere funktionen
Arkivliste (Mac OS) eller Filliste (Windows), sa der vises hele
stinavne.

For at eendre indstillingerne for Arkivliste (Mac OS) eller Fil-
liste (Windows) skal du vaelge Redigér -~ Valg - Arkivliste
(Mac OS) eller Redigér — Valg — Filliste (Windows), foretage
de gnskede a@ndringer og herefter klikke pd OK.

BEMZZARK Funktionen Arkivliste (Mac OS) eller Filliste
(Windows) i DejaVu understotter lange arkivnavne, men for-
korter (med ellipser) arkivnavne, der er leengere end menuens
bredde. Lange stinavne forkortes pd samme made.

BEMZARK DejaVu gemmer ikke bgger eller skabeloner i
Arkivlisten (Mac OS) eller Fillisten (Windows).

Standardmapper

Funktionen Standardmapper setter dig i stand til at angive stan-
dardmapper for folgende kommandoer i menuen Arkiv (Mac OS)
eller Fil (Windows): Abn, Hent tekst, Hent billede, Arkivér
(Mac OS) eller Gem (Windows) og Arkivér som (Mac OS) eller
Gem som (Windows). Funktionen Standardmapper er sldet
fra, nar programmet startes forste gang. Nar du har aktiveret en
standardsti for en kommando i menuen Arkiv (Mac OS) eller
Fil (Windows), udfeorer QuarkXPress kommandoen med de sti-
oplysninger, du har angivet. Hvis du f.eks. aktiverer en stan-
dardsti for kommandoen Hent tekst, indsetter QuarkXPress
automatisk denne sti i feltet Sog i i dialogen Hent tekst. Denne
funktion er nyttig i situationer, hvor du skal angive samme
lange og komplicerede sti, hver gang du bruger en bestemt
kommando pa menuen Arkiv (Mac OS) eller Fil (Windows).

Sadan angives en standardsti:

1 Vealg Redigér - Valg - Standardstivalg for at abne dialo-
gen Standardstivalg.

2 Valg afkrydsningsfeltet Brug standardsti for hver kommando
pa menuen Arkiv (Mac OS) eller Fil (Windows), der skal tildeles
en standardmappe. Hvis du atkrydser Brug standardsti, aktiveres
den tilsvarende knap af typen Gennemse for kommandoen.
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Brug af DejaVu (fortsat)
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3 Gennemse standardmappen. Vealg en, der passer til komman-
doen, og klik pa Veelg (Mac OS) eller OK (Windows). Standard-
stien for mappen vises i tekstvinduet for den valgte kommando
i dialogen Standardstivalg.

4 Klik pa OK i dialogen Standardstivalg for at arkivere ind-
stillingerne for dine Standardmapper.

5 Geelder kun for Mac OS: Afslut QuarkXPress, vaelg ® - Kontrol-
paneler -~ Generelt og klik pa knappen Mappe der indstilles af
programmet i omrddet Dokumenter. Klik herefter pa Luk-feltet
i dialogen Generelt og start QuarkXPress igen.

Sadan fjernes en standardsti:

1 Valg Redigér - Valg - Standardstivalg for at abne dialo-
gen Standardstivalg.

2 Fjern afkrydsningen i feltet Brug standardsti for den kom-
mando pa menuen Arkiv (Mac OS) eller Fil (Windows), der ikke
leengere skal have en standardmappe. Geelder kun for Windows:
Bemeerk, at stioplysningerne forbliver i tekstvinduet, men at
valget er blevet fjernet. Hvis du valger at bruge den samme
standardmappe pa et senere tidspunkt, skal du afkrydse Brug
standardsti for at aktivere standardstien igen.
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Kendte problemer

Nér du @endrer standardindstillingen for Arkivliste (Mac OS)
eller Filliste (Windows), far du muligvis vist dubletter af
dokumenter, der har varet dbnet for nylig, ndr du dbner dem
vha. enten Arkivliste (Mac OS) eller Filliste (Windows) eller
Arkiv >~ Abn (Mac OS) eller Fil>- Abn (Windows). For at
lose dette problem skal du slette arkivet “Dejavu.prf”, der
findes i mappen “Valg” i din Systemmappe (Mac OS) eller i
mappen “XTension” indeni QuarkXPress- eller QuarkXPress
Passport-programmappen pa Windows.
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Kontakt Quark

Se filen “Contacting Quark.pdf” pa QuarkXPress eller
QuarkXPress Passport CD-ROM’en for oplysninger om,
hvordan du kontakter Quark™.

Hvis du ikke kan fa adgang til filen “Contacting Quark.pdf,
kan du kontakte dit lokale Quark-kontor eller din Quark-
distributer.

Klik pa “Sddan kontakter du Quark” pa Quarks web-sted pa
adressen www.quark.dk, hvis du gnsker en opdateret oversigt
over Quarks kontorer og autoriserede Quark-forhandlere.

Onsker du e-mail support til QuarkXPress kan du sende en
besked til techsupport@dk.quark.ch, MacTech@quark.com
eller WinTech@quark.com.
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Juridiske oplysninger

©2000 Quark Technology Partnership mht. indholdet og arran-
gementet af dette materiale. Alle rettigheder forbeholdes.

©1986-2000 Quark Technology Partnership mht. teknologien.
Alle rettigheder forbeholdes.

Informationerne i dette dokument ma ikke sendres, distribueres
eller udbredes pd papir eller i elektronisk form uden forudgaende
skriftlig tilladelse fra Quark Technology Partnership eller dets
licenshaver, Quark, Inc.

Quark, QuarkXPress,QuarkXPress Passport og QuarkXTensions
er varemaerker, der tilhgrer Quark, Inc. og alle relevante til-
knyttede selskaber, Reg. U.S. Pat. & Tm. Off. og i mange andre
lande. Quark-logoet og DejaVu er varemeerker, der tilhgrer
Quark, Inc. og alle relevante tilknyttede selskaber.

Alle andre varemeerker tilhgrer deres respektive ejere.
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QUAR

DejaVu™ ist QuarkXTensions™-Software fiir QuarkXPress™ und
QuarkXPress Passport™, mit der Sie rascher und einfacher auf Text,
Bilder und Dokumente zugreifen konnen. DejaVu stellt dazu zwei
Moglichkeiten bereit: eine Liste der zuletzt gedffneten Doku-
mente, die im unteren Bereich des Mentis Ablage (Mac OS) oder
Datei (Windows) angezeigt wird, oder ein Hierarchiemenii aus
dem Befehl Ablage - Offnen (Mac OS) oder Datei >~ Offnen
(Windows). Aufierdem ermoglicht Ihnen DejaVu Standardordner
zu bestimmen, aus denen Text oder Bilder geladen und Doku-
mente gedffnet oder gesichert werden.

. Mindestsystemanforderungen
. DejaVu installieren fiir Mac OS
. DejaVu installieren fiir Windows
. DejaVu verwenden

. Bekannte Probleme

. Quark kontaktieren

. Rechtliche Hinweise
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Mindestsystemanforderungen

Fir Mac OS oder Windows
QuarkXPress 5.0 oder QuarkXPress Passport 5.0

m Seite 12 m
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DejaVu installieren fiir Mac OS

So installieren Sie DejaVu:
1 Beenden Sie QuarkXPress oder QuarkXPress Passport.

2 Kopieren Sie die Datei , Dejavu” von der QuarkXPress
CD-ROM in den Ordner , XTension” innerhalb des Anwen-
dungsordners fiir QuarkXPress.

3 Starten Sie QuarkXPress, um die Funktionen von DejaVu
auszufiihren.

m  Seite 13 m
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DejaVu installieren fiir Windows

So installieren Sie DejaVu:
1 Beenden Sie QuarkXPress bzw. QuarkXPress Passport.

2 Kopieren Sie die Datei , Dejavu.xnt” von der QuarkXPress
CD-ROM in den Ordner , XTension” innerhalb des Anwen-
dungsordners fiir QuarkXPress.

3 Starten Sie QuarkXPress, um die Funktionen von DejaVu
auszufiihren.
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DejaVu verwenden

Dateiliste

Uber die Funktion Dateiliste konnen Sie aus einer Liste der
zuletzt gedffneten QuarkXPress-oder QuarkXPress Passport-
Dokumente auswdhlen. Mit dieser Funktion haben Sie direkten
Zugriff auf Thre QuarkXPress-Dokumente, ohne Ablage - Off-
nen (Mac OS) oder Datei >~ Offnen (Windows) wihlen zu miis-
sen. Die Funktion Dateiliste wird beim Start der Anwendung
aktiviert, wobei standardmafig drei in alphabetischer Reihenfolge
sortierte Dateinamen im unteren Bereich des Mentis Ablage in
Mac OS bzw. des Meniis Datei in Windows angezeigt werden. Sie
konnen mindestens drei und hochstens neun zuletzt bearbeitete
Dokumente anzeigen. Sie haben die Moglichkeit der Anzeige der
Dateiliste im unteren Bereich des Meniis Ablage (Mac OS)
bzw. des Mentis Datei in Windows oder als hierarchisches
Menii, das mit Ablage — Offnen (Mac OS) bzw. Datei >
Offnen (Windows) aufgerufen wird. Zusitzlich dazu kénnen
Sie die Funktion Dateiliste so konfigurieren, dass jeweils der
vollstindige Pfad einer Datei angezeigt wird.

Zum Andern der Einstellungen fiir die Dateiliste wihlen Sie
Bearbeiten - Vorgaben — Dateiliste, nehmen die gewtiinsch-
ten Anderungen vor und klicken dann auf OK.

HINWEIS Die Funktion Dateiliste in DejaVu zeigt lange Dat-
einamen vollstindig an. Dateinamen, die jedoch die Breite des
Meniis tiberschreiten, werden gekiirzt (mit Ellipse) angezeigt.
Lange Pfadangaben werden auf dieselbe Weise gekiirzt.

HINWEIS DejaVu listet keine Biicher oder Formulare in der
Dateiliste auf.

Standardordner

Uber die Funktion Standardordner konnen Sie fiir die folgen-
den Befehle des Mentis Ablage (Mac OS) oder Datei (Windows)
Standardordner festlegen: Offnen, Text laden, Bild laden,
Sichern und Sichern unter. Die Funktion Standardordner ist
beim Start von QuarkXPress deaktiviert, wenn DejaVu geladen
ist. Wenn Sie den Standardpfad fiir einen Befehl des Meniis
Ablage (Mac OS) oder Datei (Windows) aktiviert haben, wird
in QuarkXPress dieser Befehl mit den von Ihnen angegebenen
Pfadinformationen ausgefiihrt. Wenn Sie z.B. einen Standard-
pfad fiir den Befehl Text laden aktivieren, wird in QuarkXPress
dieser Pfad automatisch im Feld Suchen in der Dialogbox Text
laden eingegeben. Diese Funktion ist dann hilfreich, wenn Sie
jedesmal denselben langen und komplizierten Pfad bei Auswahl
eines bestimmten Befehls im Menii Ablage (Mac OS) oder Datei
(Windows) angeben miissen.

So aktivieren Sie einen Standardpfad:

1 Waihlen Sie Bearbeiten - Vorgaben > Standard-
Pfadvorgaben. Damit wird die Dialogbox Standard-
Pfadvorgaben aufgerufen.
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DejaVu verwenden (Forts.)

2 Fir jeden Befehl des Meniis Ablage (Mac OS) oder Datei
(Windows), fiir den Sie einen Standardordner festlegen wollen,
markieren Sie die Checkbox Standardpfad verwenden. Dadurch
wird die dazugehorige Schaltflache Blattern aktiviert.

3 Bestimmen Sie den Standardordner. Wihlen Sie einen ent-
sprechenden Ordner fiir den Befehl aus und klicken Sie auf
Auswihlen (Mac OS) oder OK (Windows). In der Dialogbox
Standard-Pfadvorgaben wird im Textfenster fiir den gewdhlten
Befehl der Standardpfad fiir diesen Ordner angezeigt.

4 Klicken Sie in der Dialogbox Standard-Pfadvorgaben auf OK;
damit werden Ihre Einstellungen fiir Standardordner gesichert.

5 Nur Mac OS: Beenden Sie QuarkXPress, wiahlen Sie ® > Kon-
trollfelder >~ Allgemeine Einstellungen und klicken Sie auf
den Ordner, der durch die Optionsschaltfliche Programm im
Bereich Dokumente eingestellt wurde. Dann klicken Sie in
der Dialogbox Allgemeine Einstellungen auf die Schaltfliche
zum Schliefden und starten QuarkXPress neu.

So deaktivieren Sie einen Standardpfad:

1 Wihlen Sie Bearbeiten - Vorgaben - Standard-
Pfadvorgaben. Damit wird die Dialogbox Standard-
Pfadvorgaben aufgerufen.

2 Markieren Sie fiir jeden Befehl des Mentis Ablage (Mac OS)
oder Datei (Windows), dessen Standardordner Sie deaktivieren
wollen, die entsprechende Checkbox Standardpfad verwenden
ab. Nur Windows: Beachten Sie, dass die Pfadinformationen zwar
im Textfenster verbleiben, die Option aber deaktiviert wurde.
Wenn Sie denselben Standardordner spater wiederverwenden
wollen, markieren Sie die entsprechende Checkbox Standard-
pfad verwenden, um den Standardpfad zu reaktivieren.
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Bekannte Probleme

Wenn Sie die Standardeinstellung fir die Dateiliste andern, wer-
den beim Aufrufen von Dokumenten iiber die Dateiliste oder
den Befehl Ablage > Offnen (Mac OS) oder Datei > Offnen
(Windows) unter Umstdnden Duplikate der zuletzt gedffneten
Dokumente angezeigt. Um dieses Problem zu beheben, 16schen
Sie in Mac OS die Datei ,,Dejavu.prt” im Ordner ,Vorgaben
des Systemordners. Windows-Benutzer 16schen die gleichna-
mige Datei im Ordner ,XTension“ des Anwendungsordners
fiir QuarkXPress oder QuarkXPress Passport.

m Seite 17 m
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Quark kontaktieren

Informationen zur Kontaktaufnahme mit Quark™ entnehmen
Sie bitte der PDF-Datei ,Contacting Quark.pdt” auf der Quark
XPress oder QuarkXPress Passport CD-ROM.

Falls Sie nicht auf diese Datei zugreifen konnen, kontaktieren
Sie Ihren ndchsten Quark Handler oder Full Service Distributor.

Fiir eine aktuelle Liste der Quark Handler und Quark Full Service
Distributors klicken Sie auf den Link , Quark kontaktieren” auf
der Website von Quark unter www.quark.de.

Fiir Unterstiitzung von QuarkXPress via E-Mail, schicken Sie eine
Nachricht an techsupport@de.quark.ch, MacTech@quark.com
oder WinTech@quark.com.
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Rechtliche Hinweise

©2000 Quark Technology Partnership fiir den Inhalt und die
Darstellung dieses Materials. Alle Rechte vorbehalten.

©1986-2000 Quark Technology Partnership fiir die Technologie.
Alle Rechte vorbehalten.

Die Informationen in diesem Dokument diirfen ohne die vorhe-
rige schriftliche Zustimmung von Quark Technology Partnership
oder dessen Lizenznehmer Quark, Inc. weder auf Papier noch in
elektronischer Form modifiziert, verteilt oder verbreitet werden.

Quark, QuarkXPress, QuarkXPress Passport und QuarkXTensions
sind Warenzeichen von Quark, Inc. und aller betreffenden ver-
bundenen Unternehmen. Reg. U.S. Pat. & Tm. Off. und in vielen
anderen Lindern. Das Quark Logo ist ein Warenzeichen von

Quark, Inc. und aller betreffenden verbundenen Unternehmen.

Alle anderen Warenzeichen sind Eigentum der jeweiligen Inhaber.
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DejaVu™ is QuarkXTensions™ software for QuarkXPress™ software
and QuarkXPress Passport™ software that allows you to access
text, pictures, and documents with increased speed and ease.
DejaVu does this by providing you with a list of recently opened
documents as a hierarchical menu from the File > Open sub-
menu, or at the bottom of the File menu. In addition, DejaVu
allows you to designate default folders for retrieving text and
pictures, and for opening and saving documents.

. Minimum System Requirements

. Installation Instructions for Mac OS
. Installation Instructions for Windows
. Using DejaVu

. Known Problems

. Contacting Quark

. Legal Notices
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Minimum System Requirements

For Mac OS and Windows
QuarkXPress 5.0 or QuarkXPress Passport 5.0
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Installation Instructions for Mac OS

To install DejaVu, follow these steps:
1 Quit QuarkXPress or QuarkXPress Passport.

2 Copy the “Dejavu” file from the QuarkXPress CD-ROM to the
“XTension” folder within your QuarkXPress application folder.

3 Launch QuarkXPress to access the features of DejaVu.
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Installation Instructions for Windows

To install DejaVu, follow these steps:
1 Exit QuarkXPress or QuarkXPress Passport.

2 Copy the “Dejavu.xnt” file from the QuarkXPress CD-ROM to
the “XTension” folder within your QuarkXPress application folder.

3 Launch QuarkXPress to access the features of DejaVu.
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Using DejaVu

File List

The File List feature lets you select the QuarkXPress or
QuarkXPress Passport document you want to edit from a list
of recently opened and saved documents. This gives you
direct access to QuarkXPress documents without choosing
File > Open. The File List feature is enabled when the appli-
cation launches, and uses default settings that display three
file names in alphabetical order at the bottom of the File menu.
You can choose to display as few as three (or as many as nine)
recently edited and saved documents. You also have the
option to display the File List at the bottom of the File menu
or as commands in a submenu (File > Open - file list). In
addition, you can configure the File List feature to display
complete path names.

To change the File List settings, choose Edit > Preferences >
File List, make the desired changes, and then click OK.

NOTE The DejaVu File List feature accommodates long file
names, but it will truncate (with ellipses points) those that
exceed the width of the menu. Lengthy path names are sub-
ject to the same truncation effect.

NOTE DejaVu does not list books or templates in the File List.

Default Folders

The Default Folders feature lets you designate default folders
for the following File menu commands: Open, Get Text, Get
Picture, Save, and Save as. The Default Folders feature is dis-
abled when you first launch QuarkXPress with DejaVu loaded.
Once you have enabled a default path for a File menu command,
QuarkXPress executes that command with the path information
you have provided. For example, if you enable a default path
for the Get Text command, QuarkXPress automatically enters
that path at the Look in field of the Get Text dialog box. This
feature is useful in situations where you must negotiate the
same long and complex path every time you use a specific File
menu command.

To enable a default path:

1 Choose Edit > Preferences > Default Path Preferences to
display the Default Path Preferences dialog box.

2 Check the Use default path check box for each File menu
command that you want to assign to a default folder. Checking
Use default path activates the corresponding Browse button
for that command.

3 Browse for the default folder. Select one that is appropriate
for that command and click Select (Mac OS) or OK (Windows).
The default path for that folder will display in the area for the
command you checked.
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Using DejaVu (continued)
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4 Click OK in the Default Path Preferences dialog box to save
your Default Folders settings.

5 Mac OS only: Quit QuarkXPress and then choose @ -~ Control
Panels - General Controls and click the Folder that is set by
the application radio button in the Documents area. Then
click the close box on the General Controls dialog box and
relaunch QuarkXPress.

To disable a default path:

1 Choose Edit > Preferences - Default Path Preferences to
display the Default Path Preferences dialog box.

2 Uncheck the Use default path check box corresponding to
the File menu command to deselect a default folder. Windows
only: note that the path information remains in the dialog box,
but that it is inactive. Should you choose to use the same
default folder in the future, check Use default path to enable
the default path again.
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Known Problems

When you change the default File List setting, duplicates of
recently opened documents may display when you access
them by choosing either File > File List or File >~ Open.
To solve this problem, delete the “Dejavu.prt” file located
in “Preferences” folder in your System Folder on Mac OS,
or in the “XTension” folder within your QuarkXPress or
QuarkXPress Passport application folder on Windows.

m Page 26
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Contacting Quark

For information about how to contact Quark”, see the
“Contacting Quark.pdf” file on the QuarkXPress or
QuarkXPress Passport CD-ROM.

In the Americas

If you are unable to access the “Contacting Quark.pdt” file,
contact Quark Technical Support by phone at (303) 894-8899
between 7:00 a.m. and 6:00 p.m. Mountain Time, Monday

through Friday, or send an e-mail to Quark Technical Support
at MacTech@quark.com or WinTech@quark.com.

Outside the Americas
If you are unable to access the “Contacting Quark.pdf” file, con-
tact your local Quark office or Quark Full Service Distributor.

For an up-to-date list of Quark offices and Quark Full Service
Distributors, click the “Contact Quark” link on the Quark Web
site at www.quark.co.uk.

For e-mail support of QuarkXPress, send a message to
techsupport@uk.quark.ch, MacTech@quark.com, or
WinTech@quark.com.
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Legal Notices

©2000 Quark Technology Partnership as to the content and
arrangement of this material. All rights reserved.

©1986-2000 Quark Technology Partnership as to the technology.
All rights reserved.

The information in this document may not be modified, distrib-
uted, or disseminated in paper or electronic form without prior
written consent of Quark Technology Partnership or its licensee,
Quark, Inc.

Quark, QuarkXPress, QuarkXPress Passport, and QuarkXTensions
are trademarks of Quark, Inc. and all applicable affiliated com-
panies, Reg. U.S. Pat. & Tm. Off. and in many other countries.
The Quark logo and DejaVu are trademarks of Quark, Inc. and
all applicable affiliated companies.

All other trademarks are the properties of their respective owners.
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DejaVu™ se trata de software de QuarkXTensions™ para
QuarkXPress™ y QuarkXPress Passport™ que permite acceder

a texto, imagenes y documentos con mayor velocidad y
facilidad. DejaVu hace esto proporcionandole una lista de
documentos abiertos recientemente como un menu jerarquico

del submen®i Archivo - Abrir, o al final del mena Archivo.

Ademas, DejaVu permite designar las carpetas por omision
de las que obtener texto, imagenes, asi como de las que abrir
o guardar documentos.

. Requisitos minimos del sistema

. Instrucciones de instalaciéon para Mac OS
. Instrucciones de instalacion para Windows
B utilizacion de DejaVu

. Problemas identificados

. Contactos con Quark

. Avisos legales
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Requisitos minimos del sistema

Para Mac OS y Windows
QuarkXPress 5.0 o QuarkXPress Passport 5.0
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Instrucciones de instalacion para Mac OS

Para instalar DejaVu, siga los siguientes pasos:
1 Salga de QuarkXPress o QuarkXPress Passport.

2 Copie el archivo “DejaVu” del CD-ROM de QuarkXPress y
coloquelo en la carpeta “XTension” dentro de la carpeta de la
aplicacion QuarkXPress.

3 Inicie QuarkXPress para acceder a las caracteristicas de DejaVu.
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Instrucciones de instalacion para Windows

Para instalar DejaVu, siga los siguientes pasos:
1 Salga de QuarkXPress o QuarkXPress Passport.

2 Copie el archivo “Dejavu.xnt” del CD-ROM de QuarkXPress
y coloquelo en la carpeta “XTension” dentro de la carpeta de la
aplicacion QuarkXPress.

3 Inicie QuarkXPress para acceder a las caracteristicas de DejaVu.
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Lista de archivos

La caracteristica Lista de archivos hace posible seleccionar el
documento de QuarkXPress que se desee editar, de una lista de
archivos abiertos y guardados recientemente. Esto permite al
usuario acceder directamente a sus documentos de QuarkXPress
sin elegir Archivo - Abrir. La caracteristica Lista de archivos
se habilita al iniciar la aplicacion, configurada por omision para
mostrar tres nombres de archivo en orden alfabético al final del
menu Archivo. Es posible elegir que se visualicen un minimo de
tres (0 un maximo de nueve) documentos editados y guardados
recientemente. También se tiene la opcion de que la Lista de
archivos aparezca al final del ment Archivo o como comandos
en un submenu (Archivo - Abrir - lista de archivos). Ademas,
se puede configurar la caracteristica Lista de archivos para que
se visualicen los nombres de las vias de acceso completos.

Para cambiar los ajustes de la Lista de archivos, elija Edicion
Preferencias - Lista de archivos, haga los cambios deseados y
luego haga clic en OK.

NOTA La caracteristica Lista de archivos de DejaVu acepta

nombres de archivos largos, pero truncara (con puntos suspensi-
vos) aquellos que excedan la anchura del ment. Los nombres de
vias de acceso largos también seran sometidos al mismo proceso.

NOTA DejaVu no muestra libros ni plantillas en la Lista de
archivos.

Carpetas por omision

La caracteristica de carpetas por omision facilita la designa-
cion de carpetas por omision para los siguientes comandos del
menu Archivo: Abrir, Obtener texto, Obtener imagen, Guar-
dar y Guardar como. La caracteristica Carpetas por omision
esta inhabilitada al iniciar QuarkXPress con DejaVu cargado.
Una vez que se ha habilitado una via de acceso por omision
para un comando del ment Archivo, QuarkXPress ejecuta ese
comando con la informacion proporcionada. Por ejemplo, si se
habilita una via de acceso por omision para el comando Obte-
ner texto, QuarkXPress introduce automaticamente la via de
acceso en el campo Buscar en del cuadro de dialogo Obtener
texto. Esta caracteristica resulta atil en situaciones donde es
necesario utilizar la misma via de acceso larga y compleja cada
vez que se usa un comando especifico del ment Archivo.

Para habilitar una via de acceso por omision:

1 Elija Edicion - Preferencias - Preferencias de vias de
acceso por omision para que aparezca el cuadro de didlogo
Preferencias de vias de acceso por omision.

2 Para cada comando del menu Archivo al que desee asignar
una carpeta por omision, seleccione la casilla de verificacion
Utilizar via de acceso por omision respectiva. Una marca de
seleccion en esta casilla activara el boton Examinar correspon-
diente para ese comando.
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3 Busque la carpeta por omision. Seleccione una apropiada
para ese comando y haga clic en Seleccionar (Mac OS) o OK
(Windows). La via de acceso por omision para esa carpeta apa-
recera en el area para el comando seleccionado.

4 Haga clic en OK en el cuadro de didlogo Preferencias de vias
de acceso por omision a fin de guardar los ajustes de Carpetas
por omision.

5 Mac OS solamente: Salga de QuarkXPress y luego elija @ >
Paneles de control -~ General y luego haga clic en el boton de
radio Carpeta configurada por la aplicacion del area Docu-
mentos. A continuacion haga clic en el cuadro de cierre del
cuadro de didlogo General y vuelva a iniciar QuarkXPress.

Para inhabilitar una via de acceso por omision:

1 Elija Edicion > Preferencias > Preferencias de vias de
acceso por omision a fin de visualizar el cuadro de didlogo
Preferencias de vias de acceso por omision.

2 Deseleccione la casilla de verificacion Utilizar via de acceso
por omision correspondiente al comando del menu Archivo a
fin de deseleccionar una carpeta por omision. Windows solamente:
Tenga en cuenta que la informacion de la via de acceso perma-
nece en la ventana de texto, pero esa opcion ha sido desactivada.
Si decide utilizar la misma carpeta por omision en el futuro, selec-
cione la casilla de verificacion Utilizar via de acceso por omision
para habilitar de nuevo la via de acceso por omision.
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Problemas identificados

Cuando se cambian los ajustes por omision para Lista de archi-
vos, existe la posibilidad de que aparezcan duplicados de docu-
mentos abiertos recientemente cuando se accede a ellos por
medio de Archivo - Lista de archivos o Archivo - Abrir. Para
resolver este problema, suprima el archivo Dejavu.prf, situado en
la carpeta “Preferencias” en Mac OS, o en la carpeta “XTension”
dentro de la carpeta de la aplicacion QuarkXPress o QuarkXPress
Passport en Windows.
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Contactos con Quark

Encontrard la informacion para ponerse en contacto con
Quark™ en el archivo “Contacting Quark.pdf” que se incluye
en el CD-ROM de QuarkXPress o QuarkXPress Passport.

En las Américas

Si no puede acceder al archivo “Contacting Quark.pdf”, llame al
servicio de asistencia técnica de Quark al nimero (303) 894-8899,
entre las 7,00 y 18,00 horas (huso horario de la Montafa), de
lunes a viernes, o bien envie un mensaje por correo electronico a
MacTech@quark.com o a WinTech@quark.com.

Fuera de las Américas

Si le resulta imposible acceder al archivo “Contacting Quark.pdf”,
poéngase en contacto con su oficina local o distribuidor “Full
Service” de Quark.

Para obtener una lista actualizada de las oficinas y distribuido-
res “Full Service” de Quark, haga clic en el vinculo “Contactos
con Quark” del sitio Web de Quark: www.quark.co.uk.

Para recibir asistencia de Quark por correo electronico, envie
un mensaje a techsupport@uk.quark.ch, MacTech@quark.com
o WinTech@quark.com.
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Avisos legales

© Quark Technology Partnership, 2000, sobre el contenido y la
organizacion de este material. Reservados todos los derechos.

© Quark Technology Partnership, 1986-2000, sobre la tecnolo-
gia. Reservados todos los derechos.

La informacion contenida en este documento no se puede modi-
ficar, distribuir o difundir en papel o en formato electronico sin
el consentimiento previo y por escrito de Quark Technology
Partnership o su concesionario Quark, Inc.

Quark, QuarkXPress y QuarkXPress Passport son marcas comer-
ciales de Quark, Inc. y de todas las empresas afiliadas corres-
pondientes, Reg. U.S. Pat. & Tm. Off. y en otros muchos paises.
El logotipo de Quark es una marca comercial de Quark, Inc. y
de todas las empresas afiliadas correspondientes.

Las restantes marcas comerciales son propiedad de sus respecti-
vos titulares de derecho.
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DejaVu™ est un logiciel QuarkXTensions™ pour QuarkXPress™ et
QuarkXPress Passport™ permettant d’accéder aux textes, images
et documents plus rapidement et facilement. A cet effet, DejaVu
présente une liste des derniers documents ouverts sous forme
de menu hiérarchique dans le sous-menu Fichier > Ouvrir
ou située au bas du menu Fichier. En outre, DejaVu permet de
désigner des dossiers par défaut pour l’extraction de texte et
d’images et 'ouverture et I’'enregistrement de documents.

. Configuration minimale requise

. Installation de DejaVu sous Mac OS
. Installation de DejaVu sous Windows
I utilisation de DejaVu

. Problemes connus

. Comment contacter Quark

. Informations juridiques
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Configuration minimale requise

Pour Mac OS et Windows
QuarkXPress 5.0 ou QuarkXPress Passport 5.0
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Installation de DejaVu sous Mac OS

Pour installer DejaVu, procédez comme suit :
1 Quittez QuarkXPress ou QuarkXPress Passport.

2 Copiez le fichier « Dejavu » du CD-ROM QuarkXPress dans le
dossier « XTension » de votre dossier d’application QuarkXPress.

3 Lancez QuarkXPress pour accéder aux fonctionnalités
de DejaVu.
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Installation de DejaVu sous Windows

Pour installer DejaVu, procédez comme suit :
1 Quittez QuarkXPress ou QuarkXPress Passport.

2 Lancez « Déjavu.xnt » du CD-ROM QuarkXPress dans le dos-
sier « XTension » de votre dossier d’application QuarkXPress.

3 Lancez QuarkXPress pour accéder aux fonctionnalités
de DejaVu.
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Liste de fichiers

La fonction Liste de fichiers permet de sélectionner le docu-
ment QuarkXPress ou QuarkXPress Passport que vous souhaitez
modifier a partir d'une liste des derniers documents ouverts et
enregistrés. Cette liste vous donne un acces direct aux documents
QuarkXPress sans avoir a utiliser la commande Fichier > Ouvrir.
La fonction Liste de fichiers est activée au démarrage de Quark
XPress et affiche par défaut trois noms de fichiers par ordre alpha-
bétique au bas du menu Fichier. Vous pouvez choisir d’afficher
au moins les trois derniers documents modifiés et enregistrés
(et neuf au plus). Il vous est possible également d’afficher la
Liste de fichiers au bas du menu Fichier ou sous forme de
commandes dans un sous-menu (Fichier - Ouvrir > liste
de fichiers). En outre, la fonction Liste de fichiers peut étre
configurée de maniere a indiquer les noms de chemins dans
leur intégralité.

Pour modifier les parametres de la Liste de fichiers, choisissez
Edition -~ Préférences ~ Liste de fichiers, effectuez les modifi-
cations souhaitées, puis cliquez sur le bouton OK.

REMARQUE La Liste de fichiers de DejaVu gere les longs
noms de fichiers, mais les tronque (a ’aide de points de suspen-
sion) s'ils excedent la largeur du menu. Il en va de méme pour
les longs noms de chemins.

REMARQUE DejaVu ne liste pas de livres ou de gabarits dans
la Liste de fichiers.

Dossiers par défaut

La fonction Dossiers par défaut permet de désigner des dos-
siers par défaut pour les commandes de menu Fichier suivantes :
Ouvrir, Importer texte, Importer image et Enregistrer et
Enregistrer sous. Elle est désactivée au premier démarrage de
QuarkXPress avec DejaVu chargé. Des qu'un chemin par défaut
a été activé pour une commande de menu Fichier, QuarkXPress
exécute cette commande sur base des informations fournies. Par
exemple, si vous activez un chemin par défaut pour la commande
Importer texte, QuarkXPress entre automatiquement ce nom de
chemin dans le champ Chercher de la boite de dialogue Impor-
ter texte. Cette fonctionnalité est utile dans les cas ou vous devez
saisir le méme chemin long et complexe chaque fois que vous uti-
lisez une commande de menu Fichier spécifique.

Pour activer un chemin par défaut, procédez comme suit :

1 Choisissez Edition > Préférences - Préférences pour le che-
min par défaut pour afficher la boite de dialogue du méme nom.

2 Pour chacune des commandes du menu Fichier auxquelles
vous souhaitez assigner un dossier par défaut, cochez la case
Utiliser le chemin par défaut ; le bouton Naviguer correspon-
dant est ainsi activé.

3 Recherchez le dossier par défaut. Sélectionnez-en un approprié
a cette commande et cliquez sur le bouton Sélectionner (Mac OS)
ou OK (Windows). Le chemin par défaut de ce dossier apparait

dans la zone pour la commande activée.
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4 Cliquez sur le bouton OK dans la boite de dialogue Préfé-
rences pour le chemin par défaut pour enregistrer vos réglages
Dossiers par défaut.

5 Mac OS uniquement : Quittez QuarkXPress, puis choisissez @ >
Tableaux de bord - Général et activez le bouton d’option le
dossier de ’application dans la zone Documents. Cliquez
ensuite sur la case de fermeture de la zone de dialogue Géné-
ral et relancez QuarkXPress.

Pour désactiver un chemin par défaut, procédez comme suit :

1 Choisissez Edition > Préférences -~ Préférences pour le che-
min par défaut pour afficher la zone de dialogue du méme nom.

2 Décochez la case Utiliser le chemin par défaut correspondant
a la commande de menu Fichier pour désélectionner un dossier
par défaut. Windows uniquement : remarquez que les informations
relatives au chemin demeurent dans la boite de dialogue mais
qu’elles sont désactivées. Dans le cas ou vous choisissez d'utiliser
le méme dossier par défaut ultérieurement, cochez la case Utiliser
le chemin par défaut pour réactiver le chemin par défaut.
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Probléemes connus

Lorsque vous modifiez les réglages par défaut de la Liste de
fichiers, des doubles des derniers documents ouverts s’affi-
chent lorsque vous ouvrez ces documents a ’aide de la com-
mande Liste de fichiers ou Fichier - Ouvrir. Pour résoudre
ce probléme, supprimez le fichier « Dejavu.prf » placé dans le
dossier « Préférences » de votre dossier Systeme sous Mac OS
ou dans le dossier « XTension » du dossier d’application Quark
XPress ou QuarkXPress Passport sous Windows.
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Comment contacter Quark

Pour contacter Quark™, consultez le fichier « Contacting
Quark.pdf » sur le CD-ROM QuarkXPress ou QuarkXPress
Passport.

Sur le continent américain

Si le fichier « Contacting Quark.pdf » vous est inaccessible, veuillez
contacter le support technique de Quark au 303 894 8899 entre 7
et 18h (heure des Montagnes Rocheuses) du lundi au vendredi,
ou envoyez un message €lectronique au support technique de
Quark a l'adresse MacTech@quark.com ou WinTech@quark.com.

Hors du continent américain

Si le fichier « Contacting Quark.pdf » vous est inaccessible,
veuillez contacter le bureau Quark ou le distributeur Full
Service le plus proche.

Pour obtenir une liste a jour des bureaux Quark et des distri-
buteurs Full Service, cliquez sur le lien « Contacter Quark » sur
le site Web de Quark, www.quark.fr.

Pour contacter le support de QuarkXPress par message €lectro-
nique, envoyez un message a l’adresse techsupport@fr.quark.ch,
MacTech@quark.com ou WinTech@.quark.com.
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Informations juridiques

©2000 Quark Technology Partnership pour le contenu et la pré-
sentation de ce document. Tous droits réservés.

©1986-2000 Quark Technology Partnership pour la technolo-
gie. Tous droits réserves.

Les informations contenues dans ce document ne peuvent étre
modifiées, distribuées ou diffusées sous forme écrite ou électro-

nique sans "autorisation préalable écrite de Quark Technology
Partnership ou du détenteur de licence, Quark, Inc.

Quark, QuarkXPress, QuarkXPress Passport et QuarkXTensions
sont des marques de Quark, Inc. et de toutes les filiales concer-
nées, Reg. U.S. Pat. & Tm. Off. et dans de nombreux autres pays.
Le logo Quark et DejaVu sont des marques de Quark, Inc. et de
toutes les filiales concernées.

Toutes les autres marques sont détenues par leur propriétaire
respectif.
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DejaVu™ e un software QuarkXTensions™ per QuarkXPress™ e
QuarkXPress Passport™ che consente di accedere al testo, alle
immagini e ai documenti in modo piu veloce. DejaVu, infatti,
crea un elenco dei documenti che sono stati aperti recentemente,
alla fine del menu Archivio (Mac OS) oppure File (Windows),
oppure un elenco in ordine alfabetico accessibile tramite il
comando Archivio (Mac OS) oppure File (Windows) - Apri.
DejaVu inoltre consente di impostare cartelle di default per
importare testo, immagini o documenti.

Indice
B Requisiti minimi di sistema

. Installazione di DejaVu per Mac OS

. Installazione di DejaVu per Windows

B utilizzazione di DejaVu

. Problemi conosciuti

. Come contattare Quark

. Note legali
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Requisiti minimi di sistema
Per Mac OS e Windows
QuarkXPress 5.0 o QuarkXPress Passport 5.0
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Installazione di DejaVu per Mac OS

Per installare DejaVu, eseguite le seguenti operazioni:
1 Uscite da QuarkXPress o QuarkXPress Passport.

2 Copiate il file “Dejavu” dal CD-ROM QuarkXPress alla
cartella “XTension” situata all'interno della vostra cartella di
QuarkXPress.

3 Lanciate QuarkXPress per accedere alle funzionalita di DejaVu.
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Installazione di DejaVu per Windows

Per installare DejaVu, eseguite le seguenti operazioni:
1 Uscite da QuarkXPress o QuarkXPress Passport.

2 Copiate il file “Dejavu.xnt” dal CD-ROM QuarkXPress alla
cartella “XTension” situata all’interno della vostra cartella di
QuarkXPress.

3 Lanciate QuarkXPress per accedere alle funzionalita di DejaVu.
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Elenco file

Elenco file consente di selezionare il documento QuarkXPress o
QuarkXPress Passport che volete modificare dall’elenco dei docu-
menti aperti recentemente. In questo modo potete accedere diret-
tamente ai vostri documenti QuarkXPress senza dover scegliere
Archivio (Mac OS) oppure File (Windows) - Apri. La funziona-
lita Elenco file viene attivata all’avvio dell’applicazione; le impo-
stazioni di default visualizzano, in ordine alfabetico, tre nomi di
file alla fine del menu Archivio (Mac OS) oppure File (Windows).
Potete scegliere di visualizzare un minimo di tre documenti (o un
massimo di nove) che avete recentemente modificato e salvato.
E possibile di visualizzare 1'Elenco file alla fine del menu Archi-
vio (Mac OS) oppure File (Windows), oppure come comandi di
un menu secondario scegliendo il comando Archivio (Mac OS)
oppure File (Windows) > Apri > elenco file. Potete inoltre con-
figurare la funzionalita Elenco file in modo da visualizzare per
intero i nomi dei percorsi.

Per modificare le impostazioni dell’Elenco file, scegliete Comp.
(Mac OS) oppure Modifica (Windows) - Preferenze - Elenco
file, apportate le modifiche desiderate, quindi fate clic su OK.

NOTA La funzionalita Elenco file di DejaVu accetta nomi di
file estesi, ma tronchera (con punti di sospensione) quei nomi
che eccedono la larghezza del menu. Lo stesso vale per i nomi
di percorso troppo lunghi.

NOTA Nell’Elenco file di DejaVu non vengono elencati libri
o modelli.

Cartelle di default

Le Cartelle di default consentono di designare cartelle di
default per i seguenti comandi del menu Archivio (Mac OS)
oppure File (Windows): Apri, Importa testo, Importa imma-
gine, e Salva/Salva con il nome. La funzionalita Cartelle di
default viene disabilitata la prima volta che si lancia Quark
XPress con DejaVu caricato. Una volta che avete attivato un
percorso di default per un comando del menu Archivio (Mac OS)
oppure File (Windows), QuarkXPress eseguira quel comando
in base alle informazioni sul percorso che avete immesso. Se
attivate un percorso di default per il comando Importa testo,
ad esempio, QuarkXPress immettera automaticamente quel
percorso nel campo Cerca in della finestra di dialogo Importa
testo. Questa funzionalita e particolarmente utile quando
dovete impostare lo stesso percorso, lungo e complesso, ogni
volta che usate un determinato comando del menu Archivio
(Mac OS) oppure File (Windows).

Per attivare un percorso di default, eseguite le seguenti operazioni:

1 Scegliete Comp. (Mac OS) oppure Modifica (Windows) -
Preferenze - Preferenze di percorso di default per visualiz-
zare la finestra di dialogo Preferenze di percorso di default.
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2 Per ogni comando del menu Archivio (Mac OS) oppure File
(Windows) che volete assegnare alla cartella di default, contras-
segnate la casella di selezione Usa il percorso di default per
quel particolare comando. Selezionando questa casella, attive-
rete il corrispondente pulsante Naviga per quel determinato
comando.

3 Cercate la cartella di default, quindi selezionate quella appro-
priata per quel comando e fate clic Seleziona (Mac OS) o su OK
(Windows). Il percorso di default per quella cartella apparira
nella finestra di testo del comando che avete selezionato.

4 Fate clic su OK nella finestra di dialogo Preferenze di per-
corso di default per salvare le vostre impostazioni per le Car-
telle di default.

5 Solo Mac OS: uscite da QuarkXPress, quindi selezionate & >
Pannello di Controllo - Controlli Generali e fate clic sul
pulsante di opzione Cartella impostata dall’applicazione nel-
I’area Documenti. Infine chiudete la finestra di dialogo Con-
trolli Generali e rilanciate QuarkXPress.

Per disabilitare un percorso di default, eseguite le seguenti
operazioni:

1 Scegliete Comp. (Mac OS) oppure Modifica (Windows) -
Preferenze > Preferenze di percorso di default per visualiz-
zare la finestra di dialogo Preferenze di percorso di default.

2 Deselezionate la casella di selezione Usa il percorso di default
corrispondente al comando del menu Archivio (Mac OS) oppure
File (Windows) per deselezionare una cartella di default. Solo
Windows: notate che le informazioni sul percorso rimangono
nella finestra di dialogo, ma 1'opzione risulta disattivata. Se in
futuro volete usare la stessa cartella di default, selezionate la
casella di selezione Usa il percorso di default per riattivare il
percorso di default.
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Problemi conosciuti

Quando si modificano le impostazioni di default di Elenco file,
potrebbero comparire duplicati di documenti aperti recente-
mente qualora cercaste di accedere a tali documenti tramite la
funzionalita Elenco file o tramite Archivio (Mac OS) oppure File
(Windows) > Apri. Per risolvere questo problema, eliminate il
file “Dejavu.prf” che si trova nella cartella “Preferenze” della
Cartella di Sistema su Mac OS, oppure nella cartella “XTension”
situata all’interno della vostra cartella di QuarkXPress o Quark
XPress Passport su Windows.
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Come contattare Quark

Per informazioni su come contattare Quark™, consultate il
file “Contacting Quark.pdf” che troverete sul CD-ROM di
QuarkXPress o QuarkXPress Passport.

Se non riuscite ad accedere al file “Contacting Quark.pdt”, con-
tattate il vostro ufficio locale Quark o il distributore Full Service
autorizzato Quark.

Per un elenco aggiornato delgli uffici Quark e dei distributori
Full Service autorizzati Quark, fate clic su “Contact Quark” al
sito Web di Quark all’indirizzo www.quark.co.uk.

Per ricevere supporto tecnico tramite e-mail, inviate un
messaggio a techsupport@uk.quark.ch, MacTech@quark.com
o WinTech@quark.com.
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Note legali

©2000 Quark Technology Partnership per i contenuti e 1'orga-
nizzazione del presente materiale. Tutti i diritti riservati.

©1986-2000 Quark Technology Partnership per la tecnologia.
Tutti i diritti riservati.

Le informazioni contenute in questo documento non possono
essere modificate, distribuite o divulgate, in forma scritta o elet-
tronica, senza il previo consenso scritto di Quark Technology
Partnership o del suo licenziatario Quark, Inc.

Quark, QuarkXPress e QuarkXPress Passport sono marchi
commerciali di Quark, Inc. e di tutte le relative societa affi-
liate, Reg. U.S. Pat. & Tm. Off. e in molti altri paesi. Il logo
Quark e un marchio commerciale di Quark, Inc. e di tutte le
relative societa affiliate.

Microsoft € un marchio commerciale di Microsoft Corporation.

Tutti gli altri marchi commerciali sono di proprieta dei rispet-
tivi depositari.
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DejaVu™ is QuarkXTensions™-software voor QuarkXPress™- en
QuarkXPress Passport™-software waarmee u tekst, illustraties en
documenten sneller en eenvoudiger kunt openen. DejaVu doet
dit door u onderin het Archief-menu (Mac OS) of Bestand-
menu (Windows) of via een hiérarchiek menu met de Archief
(Mac OS) of Bestand (Windows) - Open-opdracht een over-
zicht te geven van de meest recent geopende documenten.
Bovendien kunt u met DejaVu standaardmappen creéren voor
het importeren van tekst of illustraties of het openen en bewa-
ren van documenten.

. Minimale systeemeisen

. De installatie van DejaVu onder Mac OS
. De installatie van DejaVu onder Windows
. Werken met DejaVu

. Bekende problemen

. Contact opnemen met Quark

. Verantwoording
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Minimale systeemeisen

Voor Mac OS en Windows
QuarkXPress 5.0 of QuarkXPress Passport 5.0
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De installatie van DejaVu onder Mac OS

Om DejaVu te installeren, moet u het volgende doen:
1 Sluit QuarkXPress of QuarkXPress Passport.

2 Kopieer het bestand “DejaVu” van de QuarkXPress CD-ROM
naar de map “XTension” in uw QuarkXPress-programmamap.

3 Start QuarkXPress om gebruik te kunnen maken van de
functies van DejaVu.
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De installatie van DejaVu onder Windows

Om DejaVu te installeren, moet u het volgende doen:
1 Sluit QuarkXPress of QuarkXPress Passport.

2 Kopieer het bestand “Dejavu.xnt” van de QuarkXPress
CD-ROM naar de map “XTension” in uw QuarkXPress-
programmamap.

3 Start QuarkXPress om gebruik te kunnen maken van de
functies van DejaVu.
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Bestandslijst

Met behulp van Bestandslijst kunt u in een lijst met recent
geopende documenten het QuarkXPress- of QuarkXPress
Passport-document kiezen dat u wilt gaan bewerken. Hierdoor
kunt u rechtstreeks uw QuarkXPress-documenten openen zon-
der Archief (Mac OS) of Bestand (Windows) - Open te moe-
ten kiezen. De Bestandslijst-functie wordt actief zodra het
programma wordt gestart, waarbij standaard onderin het
Archief-menu (Mac OS) of Bestand-menu (Windows) drie
bestandsnamen in alfabetische volgorde worden weergegeven.
U kunt opgeven dat u minimaal drie (of maximaal negen)
recent bewerkte en bewaarde documenten wilt zien. U heeft
de mogelijkheid om de Bestandslijst onderin het Archief-
menu (Mac OS) of Bestand-menu (Windows) weer te geven
of via opdrachten in een submenu (Archief (Mac OS) of
Bestand (Windows) > Open > bestandslijst). Bovendien
kunt u de Bestandslijst-functie zodanig configureren dat ook
de volledige padnamen worden weergegeven.

Om de instellingen voor Bestandslijst te wijzigen, kiest u
Wijzig (Mac OS) of Bewerk (Windows) - Voorkeuren -
Bestandslijst, waarna u de gewenste wijzigingen maakt en
vervolgens op OK klikt.

N.B. De Bestandslijst-functie van DejaVu kan lange bestands-
namen aan, maar het breekt de bestandsnamen af (met een
weglatingsteken) als deze breder dan het menu zijn. Hetzelfde
geldt voor echt lange padnamen.

N.B. DejaVu geeft in de Bestandslijst geen overzicht van boe-
ken of sjablonen.

Standaardmappen

Met Standaardmappen kunt u standaardmappen maken voor de
volgende opdrachten in het Archief-menu (Mac OS) of Bestand-
menu (Windows): Open, Importeer tekst, Importeer illustratie
en Bewaar/Bewaar als. De functie Standaardmappen wordt uit-
geschakeld wanneer het programma wordt gestart. Heeft u een-
maal een standaardpad voor een opdracht in het Archief-menu
(Mac OS) of Bestand-menu (Windows) opgezet, dan zal Quark
XPress die opdracht uitvoeren met de padinformatie die u heeft
meegegeven. Als u bijvoorbeeld een standaardpad heeft geacti-
veerd voor de opdracht Importeer tekst, zal QuarkXPress auto-
matisch die padinformatie in het veld Kijk in: in het dialoogven-
ster Importeer tekst zetten. Deze functie is handig in situaties
waarin u steeds weer die lange en ingewikkelde padinformatie
moet intikken zodra u een specifieke opdracht in het Archief-
menu (Mac OS) of Bestand-menu (Windows) gebruikt.

We gaan een standaardpad aangeven:

1 Kies Wijzig (Mac OS) of Bewerk (Windows) - Voorkeuren —
Standaard padvoorkeuren om het dialoogvenster Standaard
padvoorkeuren te openen.

2 Voor iedere opdracht in het Archief-menu (Mac OS) of
Bestand-menu (Windows) waaraan u een standaardmap wilt
toekennen, moet u het desbetreffende Gebruik standaardpad-
vakje aankruisen. Een vinkje in het aankruisvakje Gebruik
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standaardpad activeert de corresponderende Blader-knop
voor de desbetreffende opdracht.

3 Blader om de standaardmap te selecteren. Kies er een die
voor die opdracht geschikt is en klik op Selecteer (Mac OS)
of OK (Windows). Het standaardpad voor die map verschijnt
onder de opdracht die u heeft aangekruist.

4 Klik in het dialoogvenster Standaard padvoorkeuren op
OK om uw Standaardmappen-instellingen te bewaren.

5 Alleen voor Mac OS: Verlaat QuarkXPress en Kies vervolgens & -
Regelpanelen - Algemeen en klik onder Documenten op de
radioknop de door het programma ingestelde map. Klik op
het sluitvakje in het dialoogvenster Algemeen en herstart
QuarkXPress.

We gaan een standaardpad deactiveren:

1 Kies Wijzig (Mac OS) of Bewerk (Windows) > Voorkeuren —
Standaard padvoorkeuren om het dialoogvenster Standaard
padvoorkeuren te openen.

2 Deactiveer het aankruisvakje Gebruik standaardpad dat
correspondeert met de opdracht in het Archief-menu (Mac OS)
of Bestand-menu (Windows) om een standaardmap te deselec-
teren. Alleen voor Windows: U ziet dat de padinformatie in het
tekstvenster blijft staan, maar dat de optie is gedeactiveerd.
Wilt u in de toekomst dezelfde standaardmap gebruiken, dan
hoeft u alleen maar het vakje Gebruik standaardpadvoorkeu-
ren weer aan te Kruisen.
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Bekende problemen

Wanneer u de instellingen in de standaard Bestandslijst wijzigt,
kan het zijn dat u duplicaten te zien krijgt van recent geopende
documenten wanneer u ze via Archief (Mac OS) of Bestand
(Windows) - Bestandslijst of Archief (Mac OS) of Bestand
((Windows) > Open selecteert. Om dit probleem op te lossen,
moet u het “Dejavu.prf”-bestand verwijderen, dat u kunt vin-
den in de “Voorkeuren”-map in uw Systeemmap onder Mac OS
of in de map “XTension” in uw QuarkXPress- of QuarkXPress
Passport-programmamap onder Windows.
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Contact opnemen met Quark

Raadpleeg voor informatie over de manier waarop u contact
moet opnemen met Quark™ het bestand “Contacting Quark.pdt”
op de QuarkXPress of QuarkXPress Passport CD-ROM.

Indien het niet mogelijk is het bestand “Contacting Quark.pdt”
te openen, neem dan contact op met uw lokale Quark-vestiging
of Quark Full Service Distributor.

Klik voor een recente lijst met Quark-vestigingen en Quark Full
Service Distributors op de koppeling “Contact opnemen met
Quark” op de Web-site van Quark onder www.quark.nl.

Voor e-mailondersteuning m.b.t. QuarkXPress kunt u een bood-
schap sturen naar techsupport@nl.quark.ch, MacTech@quark.com
of WinTech@quark.com.
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©2000 Quark Technology Partnership wat betreft de inhoud en
vormgeving van dit materiaal. Alle rechten voorbehouden.

©1986-2000 Quark Technology Partnership wat betreft de tech-
nologie. Alle rechten voorbehouden.

De informatie in dit document mag niet worden gewijzigd,
gedistribueerd of anderszins in de roulatie gebracht in papieren
of elektronische vorm zonder voorafgaande schriftelijke toestem-
ming van Quark Technology Partnership of diens licentiehouder
Quark, Inc.

Quark, QuarkXPress en QuarkXPress Passport zijn handelsmer-
ken van Quark, Inc. en alle verbindende daarbij aangesloten
bedrijven, Reg. U.S. Pat. & Tm. Off. en in veel andere landen.
Het Quark-logo is een handelsmerk van Quark, Inc. en alle ver-
bindende daarbij aangesloten bedrijven.

Microsoft is een geregistreerd handelsmerk van Microsoft
Corporation.

Alle andere handelsmerken zijn eigendom van hun respectieve
eigenaren.
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DejaVu™ er QuarkXTensions™-programvare for QuarkXPress™
og QuarkXPress Passport™ som gjor det mulig a fa tilgang til
tekst, bilder og dokumenter pa en raskere og lettere mdte.
Dette foregdr ved at DejaVu viser en liste over nylig dpnede
dokumenter pd en hierarkisk oppbygget meny, fra under-
menyen Arkiv (Mac OS) eller Fil (Windows) — Apne, eller
nederst pd menyen Arkiv (Mac OS) eller Fil (Windows). Videre
kan du tilordne standardmapper i DejaVu for a sette inn tekst
og bilder og dpne eller arkivere/lagre dokumenter.

. Minstekrav til systemet

. Installeringsanvisninger for Mac OS
. Installeringsanvisninger for Windows
B Bruke Dejavu

. Kjente problemer

. Hvordan kontakte Quark

. Juridiske merknader
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Minstekrav til systemet

Mac OS og Windows
QuarkXPress 5.0 eller QuarkXPress Passport 5.0
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Installeringsanvisninger for Mac OS

Installer DejaVu pa folgende mate:
1 Avslutt QuarkXPress eller QuarkXPress Passport.

2 Kopier filen «Dejavu» fra CD-ROM-platen med QuarkXPress
til mappen «XTension» i programmappen for QuarkXPress.

3 Start QuarkXPress for & fa tilgang til funksjonene i DejaVu.
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Installeringsanvisninger for Windows

Installer DejaVu pa folgende mate:
1 Avslutt QuarkXPress eller QuarkXPress Passport.

2 Kopier filen «Dejavu.xnt» fra CD-ROM-platen med
QuarkXPress til mappen «XTension» i programmappen
for QuarkXPress.

3 Start QuarkXPress for a fa tilgang til funksjonene i DejaVu.
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Filliste

Med funksjonen Filliste kan du velge det QuarkXPress- eller
QuarkXPress Passport-dokumentet du vil redigere fra en liste
over nylig &pnede og lagrede dokumenter. Dermed far du direkte
tilgang til QuarkXPress-dokumenter uten a ga veien om Arkiv
(Mac OS) eller Fil (Windows) > Apne. Filliste aktiveres nar
programmet startes opp, og bruker standardinnstillinger som
viser tre filnavn i alfabetisk rekkefolge nederst pd menyen Arkiv
(Mac OS) eller Fil (Windows). Du kan vise s fa som tre (eller sa
mange som ni) nylig redigerte og lagrede dokumenter. Du kan
ogsa vise Filliste nederst pA menyen Arkiv (Mac OS) eller Fil
(Windows), eller som kommandoer pd en undermeny (Arkiv
(Mac OS) eller Fil (Windows) Apne - filliste). Videre kan du
konfigurere funksjonen Filliste til & vise fullstendige banenavn.

Du kan endre innstillingene for Filliste ved 4 velge Rediger >
Innstillinger - Filliste, utfore endringene og klikke pd OK.

MERK Funksjonen Filliste i DejaVu kan hdndtere lange fil-
navn, men vil forkorte (med ellipser) de som er lengre enn bred-
den pa menyen. Lange banenavn forkortes pd samme mate.

MERK DejaVu viser ikke bgker eller maler under Filliste.

Standardmapper

Med funksjonen Standardmapper kan du tilordne standard-
mapper for fplgende kommandoer pa menyen Arkiv (Mac OS)
eller Fil (Windows): Apne, Sett inn tekst, Sett inn bilde, Arki-
ver (Mac OS) eller Lagre (Windows), og Arkiver som (Mac OS)
eller Lagre som (Windows). Standardmapper er deaktivert
nar du starter QuarkXPress med DejaVu lastet. Med det samme
du har aktivert en standardbane for en kommando pa menyen
Arkiv (Mac OS) eller Fil (Windows), utfgrer QuarkXPress denne
kommandoen med den baneinformasjonen du har angitt. Hvis
du for eksempel aktiverer en standard bane for kommandoen Sett
inn tekst, skriver QuarkXPress automatisk inn denne banen ved
feltet Se i: i dialogruten Sett inn tekst. Denne funksjonen er der-
for nyttig i situasjoner der du ma forhandle de samme lange og
kompliserte banene hver gang du bruker en bestemt kommando
pa menyen Arkiv (Mac OS) eller Fil (Windows).

Slik aktiverer du en standardbane:

1 Velg Rediger > Innstillinger > Standard baneinnstillinger
for 4 fa fram dialogruten Standard baneinnstillinger.

2 Merk av i avmerkingsruten Bruk standardbane for hver av
kommandoene pd menyen Arkiv (Mac OS) eller Fil (Windows)
som du vil tilordne til en standardmappe. Ved a merke av Bruk
standardbane, aktiveres tilsvarende Bla gjennom-knapp for
den aktuelle kommandoen.
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3 Bla for a komme til standardmappen. Velg en som passer til
den aktuelle kommandoen, og klikk pa Velg (Mac OS) eller OK
(Windows). Standardbanen for mappen vises i feltet for kom-
mandoen du valgte.

4 Klikk pd OK i dialogruten Standard baneinnstillinger for &
arkivere/lagre innstillingene for Standardmapper.

5 Gjelder bare Mac OS: Avslutt QuarkXPress og velg ® - Kontroll-
panel > Generelt. Klikk pd knappen Mappe som bestemmes
av programmet (mappen som er angitt av programmet) under
Dokumenter. Klikk for & lukke dialogruten Generelt, og start
QuarkXPress pé nytt.

Slik deaktiverer du en standardbane:

1 Velg Rediger - Innstillinger > Standard baneinnstillinger
for 4 fa fram dialogruten Standard baneinnstillinger.

2 Opphev merkingen av avmerkingsruten Bruk standard-
bane som tilsvarer kommandoene pd menyen Arkiv (Mac OS)
eller Fil (Windows), for & oppheve merkingen av en standard-
mappe. Gjelder bare Windows: Baneinformasjonen blir stdende

i tekstvinduet, men valget er deaktivert. Hvis du skal bruke den
samme standardmappen i framtiden, merker du av Bruk stan-
dardbane for a aktivere standardbanen igjen.

m Side 70




DejaVu for QuarkXPress og QuarkXPress Passport 5.0 ‘

AR

Kjente problemer

Nér du endrer standardinnstillingene for Filliste, ser du kanskje
duplikater av nylig apnede dokumenter nar du dpner dem med
enten Arkiv (Mac OS) eller Fil (Windows) — Filliste, eller Arkiv
(Mac OS) eller Fil (Windows) — Apne. Los dette problemet ved a
slette filen «Dejavu.prf» i mappen «Innstillinger» i systemmap-
pen i Mac OS, eller i mappen «XTension» i programmappen for
QuarkXPress eller QuarkXPress Passport i Windows.
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Hvordan kontakte Quark

I filen «Contacting Quark.pdf» pd CD-ROM-platen med
QuarkXPress eller QuarkXPress Passport finner du informa-
sjon om hvordan du kan kontakte Quark™.

Hvis du ikke far tilgang til filen «Contacting Quark.pdf», kan
du ta kontakt med naermeste Quark-kontor eller -distributer
som tilbyr alle tjenester.

Hvis du ensker en oppdatert liste over Quark-kontorer og
-distributerer som tilbyr alle tjenester, kan du klikke pa
lenken «Saddan kontaker du Quark» pa Quarks web-omrade
www.quark.dk.

Hvis du trenger stotte til QuarkXPress via e-post, kan du sende
en melding til techsupport@dk.quark.ch, MacTech@quark.com
eller WinTech@quark.com.

m Side 72


http://www.quark.dk

DejaVu for QuarkXPress og QuarkXPress Passport 5.0

‘A

AR

Juridiske merknader

©2000 Quark Technology Partnership med hensyn til innhold
og tilretteleggelse av dette materiellet. Med enerett.

©1986-2000 Quark Technology Partnership med hensyn til
teknologi. Med enerett.

Informasjonen i dette dokumentet kan ikke endres, distribueres
eller mangfoldiggjores, verken pa papir eller i elektronisk format,
uten skriftlig tillatelse fra Quark Technology Partnership eller sel-
skapets lisensinnehaver, Quark, Inc.

Quark, QuarkXPress, QuarkXPress Passport og QuarkXTensions
er varemerker for Quark, Inc. og alle andre tilsluttede selskaper.
Reg. U.S. Pat. & Tm. Off. og i mange andre land. Quark-logoen og
DejaVu er varemerker for Quark, Inc. og alle tilsluttede selskaper.

Alle andre varemerker tilhorer de respektive eierne.
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DejaVu™ dr ett QuarkXTensions™-program for programmen
QuarkXPress™ och QuarkXPress Passport™ som gor att du snab-
bare och lattare kan komma at text, bilder och dokument.
DejaVu gor detta genom att tillhandahadlla en lista med nyligen
Oppnade dokument som en underordnad meny med komman-
dot Arkiv > Oppna eller lingst ned i menyn Arkiv. DejaVu
tilldter dessutom att du anger standardmappar for att hamta
text och bilder och 6ppna och spara dokument.

. Lagsta systemkrav

. Installera DejaVu for Mac OS
. Installera DejaVu for Windows
B Anvind Dejavu

. Kanda problem

. Kontakta Quark

. Juridiska meddelanden
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Lagsta systemkrav

For Mac OS och Windows
QuarkXPress 5.0 eller QuarkXPress Passport 5.0
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Installera DejaVu for Mac OS

Installera DejaVu med hjdlp av f6ljande anvisningar:
1 Avsluta QuarkXPress eller QuarkXPress Passport.

2 Kopiera filen "DejaVu” fran cd-skivan med QuarkXPress till
mappen ”“XTension” i programmappen QuarkXPress.

3 Starta QuarkXPress for att komma dt funktionerna i DejaVu.
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Installera DejaVu for Windows

Installera DejaVu med hjdlp av f6ljande anvisningar:
1 Avsluta QuarkXPress eller QuarkXPress Passport.

2 Kopiera filen "DejaVu” fran cd-skivan med QuarkXPress till
mappen ”“XTension” i programmappen QuarkXPress.

3 Starta QuarkXPress for att komma dt funktionerna i DejaVu.
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Fillista

Funktionen Fillista gor att du kan markera de QuarkXPress-
eller QuarkXPress Passport-dokument som du vill redigera i en
lista med nyligen 6ppnade och sparade dokument. Detta gor
att du kan komma at QuarkXPress-dokumenten direkt utan att
behova vilja Arkiv >~ Oppna. Funktionen Fillista aktiveras nir
programmet startas, och som standard visas tre dokument i
alfabetisk ordning langst ned i menyn Arkiv. Du kan visa minst
tre (och hogst nio) nyligen redigerade och sparade dokument.
Du kan dven visa Fillistan ldngst ned i menyn Arkiv eller som
kommandon i en underordnad meny (Arkiv >~ Oppna - fil-
lista). Du kan dessutom konfigurera funktionen Fillista sa att
hela sokvigen visas.

Andra instillningarna for Fillista genom att vilja Redigera
Instdllningar - Fillista, gor onskade dndringar och klicka
darefter pa OK.

OBS Funktionen Fillista i DejaVu klarar av ldnga filnamn,
men om de dr langre d4n bredden pa menyn forkortas namnet
(med ellipspunkter). Samma sak géller for ldnga sokvdgsnamn.

OBS DejaVu visar inte bocker eller mallar i Fillistan.

Standardmappar

Med funktionen Standardmappar kan du ange standardmappar
for féljande kommandon i menyn Arkiv: Oppna, Montera text,
Montera bild, Spara och Spara som. Funktionen Standardmap-
par dr inte aktiv ndr QuarkXPress startas med DejaVu laddad. Nar

du har etablerat en standardsokvag for ett kommando i menyn
Arkiv, kor QuarkXPress detta kommando med den sokvégsinfor-
mation du angivit. Om du t ex aktiverar en standardsokvag for
kommandot Montera text, for QuarkXPress automatiskt in
denna sokvag i faltet Leta i: i dialogrutan Montera text. Denna
funktion kan vara anvindbar ndr du behover ange samma langa
och komplicerade sokvdg varje gang du anvander ett visst kom-
mando i menyn Arkiv.

Aktivera en standardsokvag:

1 Vilj Redigera > Instidllningar - Instidllningar for stan-
dardsokvag for att Oppna dialogrutan Installningar for
standardsokvag.

2 Markera kryssrutan Anvand standardsokvag for varje kom-
mando i menyn Arkiv som du vill tilldela en standardmapp.
Nar kryssrutan Anvand standardsokvag dr markerad aktiveras
knappen Blidddra for motsvarande kommando.

3 Bldddra till standardmappen. Vilj lamplig mapp {for kom-
mandot och klicka pa Vilj (Mac OS) eller OK (Windows). Stan-
dardsokvdgen for mappen visas i textomradet for det valda
kommandot.

4 Spara instédllningarna i Standardmappar genom att klicka
pd OK i dialogrutan Installningar for standardsokvag.

5 Endast Mac OS: Avsluta QuarkXPress and toch vilj ddrefter & >
Installningar > Diverse och klicka pd alternativknappen for
den mapp som stillts in av programmet i omradet Dokument.
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Klicka dérefter pd staingningsrutan i dialogrutan Diverse och
starta om QuarkXPress.

Deaktivera en standardsokvag:

1 Vilj Redigera > Instidllningar - Instidllningar for stan-
dardsokvag for att Oppna dialogrutan Instdllningar for
standardsokvag.

2 Deaktivera standardmappen genom att avmarkera kryssru-
tan Anvind standardsokvidg som motsvarar kommandot i
menyn Arkiv. Endast Windows: observera att sokvagsinforma-
tionen blir kvar i dialogrutan, men informationen dr deaktive-
rad. Om du vill anvinda samma standardmapp i framtiden
ska du markera kryssrutan Anvind standardsokvag for att
aktivera standardsokvidgen pa nytt.
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Kanda problem

Nar du dndrar standardinstdllningen for Fillista, kan det hdnda
att kopior av nyligen 0ppnade dokument visas ndr du Oppnar
dem med hjilp av Arkiv > Fillista eller Arkiv >~ Oppna. Los
detta problem genom att ta bort filen “Dejavu.pfr” som finns i
mappen "Instdllningar” i Systemmappen pa Mac OS, eller i
mappen “XTension” i programmappen QuarkXPress eller
QuarkXPress Passport i Windows.
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Kontakta Quark

Upplysningar om hur du kontaktar Quark™, finns i filen
”Contacting Quark.pdf” pa cd-skivan med QuarkXPress eller
QuarkXPress Passport.

Om du inte kan komma at filen "Contacting Quark.pdf” ska du
kontakta det lokala Quark-kontoret eller en Quark-aterforsaljare.

Om du vill se en uppdaterad lista 6ver Quark-kontor och Quark-
aterforsdljare ska du klicka pa linken ”"Saddan kontakter du Quark”
pa Quarks webbplats pd www.quark.dk.

Du kan fa support for QuarkXPress via e-post genom att skicka ett
meddelande till techsupport@dk.quark.ch, MacTech@quark.com
eller WinTech@quark.com.
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Juridiska meddelanden

©2000 Quark Technology Partnership med avseende pd inne-
hallet i och arrangemanget av detta material. Med ensamraétt.

©1986-2000 Quark Technology Partnership med avseende pa
tekniken. Med ensamratt.

Upplysningarna i detta dokument far inte modifieras, distribue-
ras eller spridas i pappers- eller elektronisk form, utan tidigare
skriftligt medgivande fran Quark Technology Partnership eller
dess licensinnehavare, Quark, Inc.

Quark, QuarkXPress, QuarkXPress Passport och QuarkXTensions
ar varumadrken som tillhor Quark, Inc. och alla tillh6érande dot-
terbolag. Reg. U.S. Pat. & Tm. Off. Dessutom i mdnga andra lan-
der. Logotypen for Quark och DejaVu dr varumdrken som tillhor
Quark, Inc. och alla tillhorande dotterbolag.

Alla andra varumarken tillhor sina respektive dgare.

m Sida 82




